CONTACT INFORMATION

Online Resources - www.concord.edu/advancement/prmarketing

Office of Advancement
1-304-384-5211
proffice@concord.edu
PO Box 1000
Athens, WV 24712-1000

Sports Information Department
1-304-384-6259
THE PURPOSE OF THIS MANUAL

The purpose of this manual is to acquaint the various offices, divisions, departments, faculty and staff at Concord University with the University logo policies and procedures relating to the brand identity and proper use of the Concord logos.

If you are creating or ordering the creation of a publication or product to represent any aspect of Concord University, it is your responsibility to maintain the standards shown in this guide.

Please refer to this guide to answer questions that may arise regarding the use of the Concord logo. If you still have questions, contact the Office of Advancement at 1-304-384-5258.

CONTENTS

The Importance of Our Identity ........................................... 4
Who Governs the Logo Use? .............................................. 5
The University Seal .......................................................... 6
Concord Logo System ....................................................... 6
Two-Color Usage ............................................................. 7
One-Color Usage ............................................................. 7
Unacceptable Uses .......................................................... 8
Athletic Logo ................................................................. 9
Typography ...................................................................... 10
Letterhead and Business Cards ..................................... 11
Trademark Licensing ...................................................... 11
Athletic Logo Graphic Standards Guide ..................... 13
Web Design Standards ................................................... 23

WHERE DO I GET THE LOGOS USED IN THIS GUIDE?

The Concord logos, accompanying graphics or its individual elements may not be redrawn, re-proportioned, distorted or altered in any way. For reproductions of the logos contact the Office of Advancement for electronic logo files.

CU INSTITUTIONAL BRAND COLORS

The colors shown throughout this manual are not for accuracy and may not match the PANTONE Color Standards. For accurate color standards, refer to the current edition of the PANTONE Color Formula guide.
THE IMPORTANCE OF OUR IDENTITY

Since 1872, Concord University has established a distinguished legacy of quality education for many generations of students in West Virginia and the surrounding regions. Over the years, our commitment has extended to reach students in more than 34 states and 30 nations. Our name and our “face” represents a dedication to learning and service in this area, and beyond. Now, as we head into the future of extending our reach even further through online learning and the electronic campus, it is more important than ever to maintain our strong and confident identity.

By using and adhering to the standards outlined in this guide, we can ensure that our appearance always represents the strong tradition of quality learning and service that Concord University has come to embody.

FROM THE PRESIDENT

Dear Fellow Employees:

Thanks to the work of our Office of Advancement, our athletic department, and our technology services department, we have a “family” of institutional marks that will serve us well in print and electronic media. In order to unify the Concord identity, it is vital that all members of the Concord community follow the standards that are established in this guide. I have given the Office of Advancement authority to implement these graphic standards, and exceptions will be rare. They will be made only after a recommendation is made by the Office of Advancement.

Let’s own this opportunity to continue to bring Concord University to greater recognition through this institutional identity program!

Sincerely,
Kendra Boggess, President
WHO GOVERNS THE LOGO USE?

The Office of Advancement is responsible for publications produced at the university level.

If publications are found not to conform to the guidelines outlined in this manual and have not been approved as exceptions, the department or program producing the piece will be expected to take corrective action.

DO NOT try to duplicate the logos using your own fonts, etc. You can get electronic files of the logos from the Office of Advancement by calling 1-304-384-5258.

A FRIENDLY REMINDER

Due to the many desktop publishing applications, writing and designing publications is easier than ever before. This can be convenient, but not everyone is a designer or has had training or experience in producing materials for printing.

Materials and publications produced by various academic units often have a look unto themselves that may or may not be consistent with that of the rest of Concord. Because publications are one of the key marketing tools of the university, they should represent the university in a consistent and professional way. In addition, there are many factors to consider when producing materials for color printing.

If your department is going to produce a publication that will be more than one color, we suggest that you contact the Office of Advancement before you begin.

WHAT LOGOS MAY I USE?

The Concord institutional identity was designed to achieve a standardized graphic identity for administrative and academic departments throughout the university. It is to be used according to the specific guidelines outlined in this manual. For institutional letterheads, business cards and envelopes, the logo with the stylized Bell Tower logo with the words “CONCORD UNIVERSITY” underneath will be used in the designs found on page 11.

For most printed publications, one of the versions of the logo in this guide should be used, depending on the layout and other aspects of the publication.

The logos using the CU Pawprint or Mountain Lion Head are primarily for the use of the athletic department. For information on the athletic logos and their use, please see page 13.
THE UNIVERSITY SEAL

With rare exceptions, the formal university seal is reserved for ceremonies, watermarks for official documents, diplomas, and building plaques.

Using the university seal in publications must have approval from the Office of Advancement.

THE CONCORD UNIVERSITY INSTITUTIONAL LOGO

The approved version of the Concord University logo maintains a consistent identifying mark throughout the institution. It is used on all institutional identity materials (such as letterhead and business cards), as well as other publications.

The logo is the stylized “Bell Tower” with the words Concord University either centered beneath or beside the “Bell Tower”.

The stylized “Bell tower” should never be used as a separate element, without the words “CONCORD UNIVERSITY”.

This version is to be used on all official university materials and certain merchandise items, approved by the Office of Advancement.

The Concord logo provides each school, division or department a consistent element to standardize all the units that make up the university. Division- or department-specific logos can be provided by the Office of Advancement upon request.

OFFICIAL COLORS OF CONCORD UNIVERSITY

In addition to maintaining the graphic standards of our logo, it is important to maintain the consistency of our color branding. The burgundy and gray of Concord University are recognized within the higher-education community almost as instantly as our logo.

In print orders, Spot color should be requested whenever technology and budget permit. In other circumstances, CMYK equivalents provided by the printer should be proofed against standard PMS color chips.

When purchasing materials, products or other marketing elements for the university, every effort should be made to match the PMS colors.

BURGUNDY/MAROON
PMS 202

GRAY
PMS 430

PANTONE PROCESS BLACK
**TWO-COLOR CU LOGO**

The preferred Concord University logo is the two-color version using the specified Concord Burgundy and Black. When using the logo on a burgundy background, the burgundy “Concord University” may be replaced with white while keeping white behind the tower (example to the right). No other colors may be used for the two-color logo. For legibility purposes, the logo may not print in Burgundy and Gray...only Burgundy and 100% Black.

Concord Burgundy is a specific Pantone Color, PMS 202.

Different interpretations of the logo would be:

- CMYK equivalents, allowing the logo to be printed in process color.
- World Wide Web and other electronic applications that require RGB equivalents.

If and when spot color must be used on communications material, it should complement the university’s official burgundy (PMS 202) and the one-color version of the logo should be used.

**ONE-COLOR CU LOGO**

The official ink color of the one-color logo is PMS 202. This should be used whenever possible.

In instances where budgetary constraints are a factor the one-color logo version may print in 100% Black.

There is also a one-color white logo that may be used when the project dictates that you need to place the logo on a dark background. This logo is not a direct reverse of color from the original logo. As you can see in the example, the dark parts of the tower on the original logo have been replaced with the dark background the logo is placed on.

If you are using the logo in a publication that does not use the Concord Burgundy or Black ink, the logo should be printed in the darkest ink used. Approval by the Office of Advancement of this type of usage (logo color not black or Concord burgundy) will be relatively rare.

In addition, Concord University uses an official Gray color when possible. The Concord Gray is a specific Pantone Color, PMS 430, NOT a percentage of black. However, for legibility purposes, the logo and most text should always use 100% black instead of substituting PMS 430.
**UNACCEPTABLE USES**

In order to create a strong, unified Concord brand identity, it is imperative to avoid improper uses of the logo.

The logo is NOT to be altered in any way including stretching or distorting. The stylized elements of the logo, the official Concord burgundy color, as well as the typography are all integral elements of the logo. These elements should not be modified.

Do not alter or allow the logo to be altered in any form, including:

**DO NOT STRETCH OR CONDENSE THE LOGO**

**DO NOT DISPLAY THE LOGO AT AN ANGLE**

**DO NOT ISOLATE THE LOGO IN A FRAME**

**DO NOT USE UNOFFICIAL COLORS**

**DO NOT USE A SUBSTITUTE FONT**

For more information on Concord’s official fonts please refer to page 10.
UNACCEPTABLE USES

(Continued)

DO NOT ADD ANY GRAPHIC ELEMENTS TO THE OFFICIAL LOGO OR COMBINE IT WITH ANY OTHER LOGOS

DO NOT USE LOW-RESOLUTION OR ILLEGIBLE VERSIONS OF THE LOGO IN ANY PRINTED MATERIALS

DO NOT ALTER THE PROPORTIONS OF THE WORDS “CONCORD UNIVERSITY” OR THE STYLIZED “BELL TOWER”

DO NOT USE THE LOGO ON A BUSY BACKGROUND

ATHLETIC LOGOS

The athletic logos shown below should be used only for athletic purposes and sports related publications. For more information on the use of the athletic logos see page 13 or call the Office of Advancement at 1-304-384-5258.
LOGO AND PUBLICATION FONTS

The typeface Trajan Pro-Bold is the typeface used to create the words "CONCORD UNIVERSITY" in the logo. Trajan Pro-Bold is also used in printed publications for purposes such as header and subhead text.

TRAJAN PRO-BOLD

ABCDEFGHIJKLMNOPQUSTUVWXYZ
1234567890

The typeface Myriad Pro is a typeface used in printed publications for headers, subheaders, and body text. Myriad Pro-Semibold is also the typeface used in the university unit name below the logo.

MYRIAD PRO-BOLD

ABCDEFGHIJKLMNOPQUSTUVWXYZ
1234567890

MYRIAD PRO-SEMIBOLD

ABCDEFGHIJKLMNOPQRSTUVWXYZ
1234567890

MYRIAD PRO-ITALIC

ABCDEFGHIJKLMNOPQUSTUVWXYZ
1234567890

MYRIAD PRO-REGULAR

ABCDEFGHIJKLMNOPQUSTUVWXYZ
1234567890

The typeface Cambria may be used for centering the mailing or web address below the Concord University logo in certain instances. Cambria is also used for the body text and header text in many of our printed publications.

CAMBRIA PRO-BOLD

abcdefghijklmnopqrstuvwxyz
1234567890

CAMBRIA PRO-ITALIC

abcdefghijklmnopqrstuvwxyz
1234567890

CAMBRIA PRO-REGULAR

abcdefghijklmnopqrstuvwxyz
1234567890

CAMBRIA PRO-ITALIC

abcdefghijklmnopqrstuvwxyz
1234567890

If creating a publication, attempt to use Trajan Pro, Myriad Pro, or Cambria in conjunction with the Concord logo. In the absence of these fonts, Times or Times New Roman may be used if approved. While these fonts are not intended to be used exclusively, they should be used when possible in order to build a strong, consistent visual identity for the University.
USES OF THE LOGO IN CREATING PUBLICATIONS

The official logo must be on all University publications. Under no circumstance should any unit be designing its own “identity” and using it as a logo on its publication materials.

When creating a publication, from a flyer to a department website, you should consider the Concord logo as what is - a logo, not a central design element for your publication. The logo is not to be used as a headline; it is a design element.

The most important element on the cover of brochures and publications is to say and show something that attracts the attention of the audience you want to reach, rather than depend on a large logo and the name of the academic unit.

Do not allow design elements on your publication to interfere with the logo. Always maintain a “breathing” space around the logo. Think of the logo as a “stamp” that Concord approves of the piece you have created to present.

If you need assistance, contact the Office of Advancement at 1-304-384-5258.

LETTERHEAD, ENVELOPES AND BUSINESS CARDS

The Office of Advancement has developed the official Concord University letterhead, envelopes and business cards. No individual or office should attempt to create their own letterhead or business cards.

Letterhead, envelopes and business cards, as well as many other types of printed material that may be appropriate for your event or purpose (invitations, notecards, apparel and other marketing materials) may be ordered through Campus Printing Services, when appropriate, by contacting the Office of Advancement at 1-304-384-5258.

TRADEMARK LICENSING

Concord University has a trademark licensing program in place that allows promotion of its image through such products while protecting the trademarked status of such marks and symbols. For specific information regarding the trademark licensing program, including obtaining a license, contact the Office of Advancement at 1-304-384-5211.
OFFICIAL COLORS OF CONCORD ATHLETICS

Primary Colors

- Burgundy/Maroon: PMS 202
- Gray: PMS 430

Secondary Colors

- Black
- White
LOGO DESIGN SPECIFICATIONS

Below are the one color horizontal and vertical logos in how they were laid out and designed. Please note that the bottom right leg of the letter “N” in “Concord” when rotated 90˚ is used as a measuring tool for many parts of the logo. This is shown directly below.
CONCORD MOUNTAIN LIONS LOGOS

Primary Logos

Secondary Logos

Tertiary Logos
ATHLETIC LOGOS

LOGO COLOR VARIATIONS

All of the Concord University Mountain Lion logos may be used in full color (CU Maroon, CU Gray, and white), all CU Maroon, all CU Gray and all black. Some examples are shown to the right. Concord University Mountain Lion logos can be used in all white on dark backgrounds and full color on dark backgrounds as shown below.

Full Color

CU Mountain Lion Maroon

CU Mountain Lion Gray

Black

Please note that these color variation options carry over to the secondary and tertiary (page 16) Concord University Mountain Lion logos, as well as the special use logos (page 18).

One color outline logos - can be used with any of the official colors of Concord University Athletics
**Special Use Logos**

Full Color Logos

Full Color Logos can be provided with the “CU” from the Secondary Logo (Page 16) in place of the mountain lion head seen above.

Rectangle Text Logos

The secondary text under “Concord” can have the same proportion to “Concord” as “Mountain Lions” does in the logo design specifications (page 15).

Horizontal Text Logos

or it can be enlarged to line up with the edges of “Concord”.

Concord Crazies - Student Section Logo

Special use logos are available for many sports, athletic events and athletic groups. The logos seen here are not all of the special use logos available. An event specific or sport specific logo can be obtained or created by contacting the Concord University Athletic Department by phone at 1-304-384-6259.
LOGO SAFE ZONES

Each of the CU Mountain Lion logos has an established safe zone. This safe zone is intended to maintain the logo's integrity and to avoid visual confusion. No other type or graphic element (including folds, trims, or edges) should fall within the safe zone.

1. The safe zone for the primary logo and most square logos is equal to one eighth of the height of the logo ($Z = \text{height of logo}$, $1/8 Z = \text{safe zone}$). Either the Rectangle Safe Zone or the Slanted Safe Zone may be used depending on the design of the piece the logo is being used in as well as the elements around the logo.

2. The safe zone for rectangle text logos is equal to one fifth of the height of the logo ($Z = \text{height of logo}$, $1/5 Z = \text{safe zone}$). Either the Rectangle Safe Zone or the Slanted Safe Zone may be used depending on the design of the piece the logo is being used in as well as the elements around the logo.

3. The safe zone for horizontal text logos is equal to one third of the height of the logo ($Z = \text{height of logo}$, $1/3 Z = \text{safe zone}$). Either the Rectangle Safe Zone or the Slanted Safe Zone may be used depending on the design of the piece the logo is being used in as well as the elements around the logo.
**LOGO/STYLE FONTS**

Fonts compatible with the CU Mountain Lion logo and identity are Impact and Trajan Pro - Bold. The primary Impact font is a skewed version. The original version of the font is also used. In some instances, Trajan Pro - Bold, the primary Concord University academic font may be used along side or in athletic graphics.

To request permission to use other fonts, please contact the Concord University Office of Advancement.

---

**PRIMARY CU ATHLETIC FONT - IMPACT - REGULAR (SKEWED/SHEARED)**

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
0123456789
```

- TRACKING = -2
- VERTICAL SCALE = 75%
- SKEW/SHEAR (FALSE ITALIC) = 20°

---

**SECONDARY CU ATHLETIC FONT - IMPACT - REGULAR**

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
0123456789
```

- TRACKING = 20
- VERTICAL SCALE = 100%
- SKEW/SHEAR (FALSE ITALIC) = 0°

---

**PRIMARY CU ACADEMIC FONT - TRAJAN PRO - BOLD**

```
ABCDEFGHIJKLMNOPQRSTUVWXYZ
0123456789
```

- TRACKING = VARIES
- VERTICAL SCALE = 100%
- SKEW/SHEAR (FALSE ITALIC) = 0°

---

**SECONDARY UNIVERSITY FONTS USED**

**MYRIAD PRO**

- TRACKING = VARIES
- VERTICAL SCALE = 100%
- SKEW/SHEAR (FALSE ITALIC) = 0°

**CAMBRIA**
Creating the Logo Font

Note: Font directions are Adobe Creative Suite specific

1. Type the word needed in the font “Impact”

2. Set the character specifications to:
   - Font size = 130
   - Tracking = -2
   - Vertical Scale = 75%

   • Shear the text at 20° (In Adobe Illustrator, go to Object > Transform > Shear > and type 20 in Shear Angle)

   • Note: Shearing the text will change the Horizontal Scale to 93.97%. Adobe Illustrator Character window should look like the window below

3. Expand or Outline the text (in Adobe Illustrator, go to Object > Expand, or Type > Create Outlines). Then copy and paste the text in front, move the copied text behind the original, swap the fill and stroke, change the stroke to 17 points, then outline the stroke (Object > Path > Outline Stroke)

4. Adjust colors & overall scale based on design